Chapter 160

Non-Inferiority Tests for Two Correlated Proportions

Introduction

These modules compute power and sample size for non-inferiority tests in which two dichotomous responses are measured on each subject. When one is interested in showing that the true proportions are different, the data are often analyzed with McNemar’s test. However, we are interested in showing non-inferiority rather than difference. For example, suppose a diagnostic procedure is accurate, but is expensive to apply or has serious side effects. A replacement procedure is sought which is no less accurate, but is less expensive or has fewer side effects. In this case, we are not interested in showing that the two diagnostic procedures are different, but rather that the second is no worse than the first. Non-inferiority tests were designed for this situation.

These tests are often divided into two categories: equivalence (two-sided) tests and non-inferiority (one-sided) tests. Here, the term equivalence tests means that we want to show that two diagnostic procedures are equivalent—that is, their accuracy is about the same. This requires a two-sided hypothesis test. On the other hand, non-inferiority tests are used when we want to show that a new (experimental) procedure is no worse than the existing (reference or gold-standard) one. This requires a one-sided hypothesis test. The procedures discussed in this chapter deal with the non-inferiority (one-sided) case.

Technical Details

The results of a study in which two dichotomous responses are measured on each subject can be displayed in a 2-by-2 table in which one response is shown across the columns and the other is shown down the rows. In the discussion to follow, the columns of the table represent the standard (reference or control) response and the rows represent the treatment (experimental) response. The outcome probabilities can be classified into the following table.

<table>
<thead>
<tr>
<th>Experimental Diagnosis</th>
<th>Standard Diagnosis</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Yes</td>
<td>$p_{11}$</td>
<td>$p_{10}$</td>
</tr>
<tr>
<td>No</td>
<td>$p_{01}$</td>
<td>$p_{00}$</td>
</tr>
<tr>
<td>Total</td>
<td>$P_S$</td>
<td>$1 - P_S$</td>
</tr>
</tbody>
</table>
In this table, \( p_{ij} = p_{\text{Treatment, Standard}} \). That is, the first subscript represents the response of the new, experimental procedure while the second subscript represents the response of the standard procedure. Thus, \( p_{01} \) represents the proportion having a negative treatment response and a positive standard response.

**Sensitivity, Specificity, and Prevalence**

To aid in interpretation, analysts have developed a few proportions that summarize the table. Three of the most popular ratios are sensitivity, specificity, and prevalence.

**Sensitivity**

Sensitivity is the proportion of subjects with a positive standard response who also have a positive experimental response. In terms of proportions from a 2-by-2 table,

\[
\text{Sensitivity} = \frac{p_{11}}{p_{01} + p_{11}} = \frac{p_{11}}{P_s}
\]

**Specificity**

Specificity is the proportion of subjects with a negative standard response who also have a negative experimental response. In terms of proportions from a 2-by-2 table,

\[
\text{Specificity} = \frac{p_{00}}{p_{10} + p_{00}}
\]

**Prevalence**

Prevalence is the overall proportion of individuals with the disease (or feature of interest). In terms of proportions from a 2-by-2 table,

\[
\text{Prevalence} = P_s
\]

**Table Probabilities**

The outcome counts from a sample of \( n \) subjects can be classified into the following table.

<table>
<thead>
<tr>
<th>Experimental Diagnosis</th>
<th>Standard Diagnosis</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes</td>
<td>Yes</td>
<td>( n_{11} )</td>
</tr>
<tr>
<td></td>
<td>No</td>
<td>( n_{10} )</td>
</tr>
<tr>
<td></td>
<td></td>
<td>( n_T )</td>
</tr>
<tr>
<td>No</td>
<td>Yes</td>
<td>( n_{01} )</td>
</tr>
<tr>
<td></td>
<td>No</td>
<td>( n_{00} )</td>
</tr>
<tr>
<td></td>
<td></td>
<td>( n - n_T )</td>
</tr>
<tr>
<td>Total</td>
<td>Yes</td>
<td>( n_S )</td>
</tr>
<tr>
<td></td>
<td>No</td>
<td>( n - n_S )</td>
</tr>
<tr>
<td></td>
<td></td>
<td>( n )</td>
</tr>
</tbody>
</table>

Note that \( n_{11} + n_{00} \) is the number of matches (concordant pairs) and \( n_{10} + n_{01} \) is the number of discordant pairs.

The hypothesis of interest concerns the two marginal probabilities \( P_T \) and \( P_S \). \( P_T \) represents the accuracy or success of the standard test and \( P_S \) represents the accuracy or success of the new, experimental test. Non-inferiority is defined in terms of either the difference, \( D = P_T - P_S \), or the relative risk ratio, \( R = P_T / P_S \), of these two proportions. The choice between \( D \) and \( R \) will usually lead to different sample sizes to achieve the same power.
Non-Inferiority Hypotheses using Differences

This section is based on Liu, Hsueh, Hsieh and Chen (2002). Refer to that paper for complete details.

The null and alternative hypotheses of non-inferiority in terms of the difference are

\[ H_0 : \hat{P}_T - \hat{P}_S \leq -D_E \text{ versus } H_1 : \hat{P}_T - \hat{P}_S > -D_E \]

To demonstrate non-inferiority, one desires to reject the null hypothesis and thus conclude that the experimental treatment is not worse than the standard by as much or more than \( D_E \). In the context of the preceding statement, \( D_E \) is defined to be positive. The choice of an appropriate \( D_E \) may be difficult. It should be clinically meaningful so that clinicians are willing to conclude that the experimental treatment is acceptable if the difference is less than \( D_E \). From a statistical perspective, \( D_E \) should be less than the effect, if known, of the standard treatment compared to placebo.

Liu et al. (2002) discuss the RMLE-based (score) method for constructing these confidence intervals. This method is based on (developed by, described by) Nam (1997).

Asymptotic Tests

An asymptotic test is given by

\[ Z_L = \frac{\hat{D} + D_E}{\hat{\sigma}} = \frac{c + nD_E}{\sqrt{d - n\hat{D}^2}} \geq z_\alpha \]

where

\[ \hat{D} = \frac{n_T}{n} - \frac{n_S}{n} = \frac{n_{10}}{n} - \frac{n_{01}}{n} \]

\[ d = n_{10} + n_{01} \]

\[ c = n_{10} - n_{01} \]

and \( z_\alpha \) is the standard normal deviate having \( \alpha \) in the right tail.

An estimate of \( \hat{\sigma} \) based on the RMLE-based (score) procedure of Nam (1997) uses the estimates

\[ \tilde{\sigma}_L = \sqrt{\frac{\tilde{p}_{L,10} + \tilde{p}_{L,01} - D_E^2}{n}} \]

where

\[ \tilde{p}_{L,10} = \frac{-\tilde{a}_L + \sqrt{\tilde{a}_L^2 - 8\tilde{b}_L}}{4} \]

\[ \tilde{p}_{L,01} = \tilde{p}_{L,10} - D_E \]

\[ \tilde{a}_{L,01} = -\hat{D}(1 - D_E) - 2(\hat{p}_{01} + D_E) \]

\[ \tilde{b}_{L,01} = D_E(1 + D_E)\hat{p}_{01} \]
Non-Inferiority Tests for Two Correlated Proportions

Power Formula

The power when the actual difference is $D_A$ can be evaluated exactly using the multinomial distribution. However, when the sample size is above a user-set level, we use a normal approximation to this distribution which leads to

$$1 - \beta(D_A) = \begin{cases} \Phi(c_L) & \text{if } D_A > -D_E \\ 0 & \text{otherwise} \end{cases}$$

where

$$c_L = -\frac{D_A - D_E}{\sigma} + z_\alpha$$

$$\sigma = \sqrt{\frac{p_{01} + p_{10} - D_A^2}{n}}$$

$$w_L = \sqrt{\frac{2p_{01} + D_A - D_A^2}{2p_{L,01} - D_E - D_E^2}}$$

$$\bar{p}_{L,01} = -a_L + \sqrt{a_L^2 - 8b_L}$$

$$a_L = -D_A(1 - D_E) - 2(p_{01} + D_E)$$

$$b_L = D_E(1 + D_E)p_{01}$$

Non-Inferiority Hypotheses using Ratios

The following is based on Nam and Blackwelder (2002). We refer you to this paper for the complete details of which we will only provide a brief summary here.

When $R_E < 1$, the statistical hypotheses of non-equivalence are

$$H_0: \frac{P_T}{P_S} \leq R_E \text{ versus } H_1: \frac{P_T}{P_S} > R_E$$

Test Statistics

The test statistic for an asymptotic test based on constrained maximum likelihood for large $n$ is given by

$$Z(R_E) = \sqrt{\frac{n(\hat{P}_T - R_E \hat{P}_S)}{R_E(\bar{p}_{10} + \bar{p}_{01})}}$$

where

$$\bar{p}_{10} = \frac{-\hat{P}_T + R_E^2(\hat{P}_S^2 + 2\hat{P}_{10}) + \sqrt{(\hat{P}_T - R_E^2\hat{P}_S)^2 + 4R_E^2\hat{P}_{10}\hat{P}_{01}}}{2R_E(R_E + 1)}$$
Non-Inferiority Tests for Two Correlated Proportions

\[
\tilde{p}_{01} = R_E \tilde{p}_{10} - (R_E - 1)(1 - \tilde{p}_{00})
\]

\[
\hat{p}_{01} = \frac{n_{01}}{n}, \quad \hat{p}_{10} = \frac{n_{10}}{n}, \quad \hat{P} = \frac{n_{10} + n_{11}}{n}, \quad \hat{S} = \frac{n_{01} + n_{11}}{n}
\]

Power Formula

The power when the true value of the relative risk ratio is \( R_E \) can be evaluated exactly using the multinomial distribution. When \( n \) is large, we use a normal approximation to the multinomial distribution which leads to

\[
\beta(R_A) = \Phi(c_U)
\]

where

\[
c_U = z_{1-\alpha} \sqrt{\frac{\tilde{V}_0(T_0) - E_1(T_0)}{V_1(T_0)}}
\]

\[
\tilde{V}_0(T_0) = \frac{R_E (\tilde{p}_{10} + \tilde{p}_{01})}{n}
\]

\[
E_1(T_0) = (R_A - R_E) P_S
\]

\[
V_1(T_0) = \frac{(R_A + R_E^2) P_S - 2R_E P_{11} - (R_A - R_E)^2 P_S^2}{n}
\]

\[
\tilde{p}_{10} = \frac{-P_T + R_E^2 (P_S + 2P_{10}) + \sqrt{(P_T - R_E^2 P_S)^2 + 4R_E^2 P_{10} P_{01}}}{2R_E (R_E + 1)}
\]

\[
\tilde{p}_{01} = R_E \tilde{p}_{10} - (R_E - 1)(1 - p_{00})
\]

Nuisance Parameter

Unfortunately, the 2-by-2 table includes four parameters \( p_{11}, p_{10}, p_{01}, \) and \( p_{00}, \) but the power specifications above only specify two parameters: \( P_S \) and \( D_A \) or \( R_A. \) A third parameter is defined implicitly since the sum of the four parameters is one. One parameter, known as a nuisance parameter, remains unaccounted for. This parameter must be addressed to fully specify the problem. This fourth parameter can be specified by specifying any one of the following: \( p_{11}, p_{10}, p_{01}, p_{00}, p_{10} + p_{01}, p_{11} + p_{00}, \) or the sensitivity of the experimental response, \( P_{11} / P_S. \)

It may be difficult to specify a reasonable value for the nuisance parameter since its value may not be even approximately known until after the study is conducted. Because of this, we suggest that you calculate power or sample size for a range of values of the nuisance parameter. This will allow you to determine how sensitive the results are to its value.
Procedure Options

This section describes the options that are specific to this procedure. These are located on the Design tab. For more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab (Common Options)

The Design tab contains the parameters associated with this test such as the proportions, sample sizes, alpha, and power. This chapter covers two procedures which have different options. This section documents options that are common to both procedures. Later, unique options for each procedure will be documented.

Solve For

This option specifies the parameter to be solved for from the other parameters. The parameters that may be selected are Power or Sample Size.

Power and Alpha

Power

This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis, and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null hypothesis is not rejected. Here, a type-II error occurs when you fail to conclude non-inferiority when in fact it is true.

Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now, 0.90 (Beta = 0.10) is also commonly used.

A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.

Alpha

This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true null hypothesis is rejected. Here, a type-I error occurs when you falsely conclude non-inferiority.

Sample Size

N (Sample Size)

Enter a value for the sample size. This value must be greater than two. You may enter a range of values such as 10 to 100 by 10.

Effect Size – Standard Proportion

Ps (Standard Proportion)

This is the proportion of yes’s (or successes), $P_s$, when subjects received the standard treatment. This value or a good estimate is often available from previous studies.

You may enter a set of values separated by blank spaces. For example, you could enter ‘0.50 0.60 0.70’. Values between, but not including, 0 and 1 are permitted.
**Effect Size – Nuisance Parameter**

**Nuisance Parameter Type**
Enter the type of nuisance parameter here. Unfortunately, the 2-by-2 table cannot be completely specified by using only the parameters $P_s$ and $D_a$ or $P_s$ and $R_a$. One other parameter must be specified. This additional parameter is called a ‘nuisance’ parameter. It will be assumed to be a known quantity. Several possible choices are available. This option lets you specify which parameter you want to use. In all cases, the value you specify is a proportion.

- **$P_{11}$**
  The proportion of subjects that are positive on both tests.

- **$P_{00}$**
  The proportion of subjects that are negative on both tests.

- **$P_{01}$**
  The proportion of subjects that are negative on the treatment, but positive on the standard.

- **$P_{10}$**
  The proportion of subjects that are positive on the treatment, but negative on the standard.

- **$P_{11} + P_{00}$**
  The proportion of matches (concordant pairs).

- **$P_{01} + P_{10}$**
  The proportion of non-matches (discordant pairs).

- **$P_{11}/P_s$**
  The sensitivity.

**Nuisance Parameter Value**
Enter the value of the nuisance parameter that you specified in the ‘Nuisance Parameter Type’ box. This value is a proportion, so it must be between 0 and 1.

**Design Tab (Differences)**

This section documents options that are used when the parameterization is in terms of the difference, $P_1 - P_2$. $P_{1.0}$ is the value of $P_1$ assumed by the null hypothesis and $P_{1.1}$ is the value of $P_1$ at which the power is calculated. Once $P_2$, $D_0$, and $D_1$ are given, the values of $P_{1.1}$ and $P_{1.0}$ can be calculated.

**Effect Size – Differences**

|De| (Equivalence Difference)

$D_e$ is the maximum allowable difference between the standard and treatment proportions that will still result in the conclusion of equivalence. In order to ensure that $D_e$ is positive, the difference is computed in reverse order. That is, $D_e = P_s - P_t$. This parameter is only used when the Test Statistic option is set to ‘Difference’.

Only positive values can be entered here. Typical values for this difference are 0.05, 0.10, and 0.20. For two-sided tests, you must have $|D_a| < D_e$. For one-sided tests, you must have $D_a > -D_e$.  

© NCSS, LLC. All Rights Reserved.
**Da (Actual Difference)**

Da is the actual difference between the treatment and standard proportions \( D_A = P_T - P_S \). Da may be positive, negative, or (usually) zero. This parameter is only used when the Test Statistic option is set to 'Difference'.

For two-sided tests, you must have \(|Da| < De\). For one-sided tests, you must have \(Da > -De\).

---

**Design Tab (Ratios)**

This section documents options that are used when the parameterization is in terms of the ratio, \( P_1 / P_2 \). \( P_{1.0} \) is the value of \( P_1 \) assumed by the null hypothesis and \( P_{1.1} \) is the value of \( P_1 \) at which the power is calculated. Once \( P_2, R_0, \) and \( R_1 \) are given, the values of \( P_{1.0} \) and \( P_{1.1} \) can be calculated.

---

**Effect Size – Ratios**

**Re (Equivalence Ratio)**

Re is the minimum size of the relative risk ratio, \( P_T / P_S \), that will still result in the conclusion of equivalence. Both equivalence and non-inferiority trials use a value that is less than one. Typical values for this ratio are 0.8 or 0.9.

This parameter is only used when the Test Statistic option is set to ‘Ratio’.

**Ra (Actual Ratio)**

Enter a value for Ra, the actual relative risk ratio \( P_T / P_S \). This value is used to generate the value of \( P_T \) using the formula \( P_T = P_S R_a \). Often this value is set equal to one, but this is not necessary.

---

**Options Tab**

This tab sets options used in estimation.

---

**Approximations**

**Use Approximations if N is greater than**

Specify the maximum value of N (sample size) for which you would like an exact power calculation based on the multinomial distribution. Sample sizes greater than this value will use the asymptotic approximation given in the documentation. The exact calculation of the multinomial distribution becomes very time consuming for \( N > 200 \). For most cases, when \( N > 200 \), the difference between the exact and approximate calculations is small. For \( N > 200 \), the length of time needed to calculate the exact answer may become prohibitive. However, as the speed of computers increases, it will become faster and easier to calculate the exact power for larger values of N.

If you want all calculations to use exact results, enter “1000” here.

If you want all calculations to use the quick approximations, enter “1” here.
Example 1 – Finding Power

A clinical trial will be conducted to show that a non-invasive MRI test is not inferior to the invasive CTAP reference test. Historical data suggest that the CTAP test is 80% accurate. After careful discussion, the researchers decide that if the MRI test is 75% accurate or better, it will be considered non-inferior. They decide to use a difference test statistic. Thus, the equivalence difference is 0.05. They want to study the power for various sample sizes between 20 and 1000 at the 5% significance level.

They use P01 as the nuisance parameter and look at two values: 0.05 and 0.10.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Non-Inferiority Tests for Two Correlated Proportions using Differences procedure window by expanding Proportions, then Two Correlated Proportions, then clicking on Non-Inferiority, and then Non-Inferiority Tests for Two Correlated Proportions using Differences. You may then make the appropriate entries as listed below, or open Example 1 by going to the File menu and choosing Open Example Template.

Option Value
Design Tab
Solve For ................................................ Power
Alpha ....................................................... 0.05
N (Sample Size)...................................... 20 100 200 300 450 600 800 1000
|De| (Equivalence Difference) ................. 0.05
Da (Actual Difference) ........................... 0.00
Ps (Standard Proportion) ..................... 0.80
Nuisance Parameter Type ..................... P01
Nuisance Parameter Value ................. 0.05 0.10

Annotated Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

<table>
<thead>
<tr>
<th>Power</th>
<th>Sample Size (N)</th>
<th>Equiv. Difference (De)</th>
<th>Actual Difference (Da)</th>
<th>Treatment Proportion (Pt)</th>
<th>Standard Proportion (Ps)</th>
<th>Nuisance Parameter (P01)</th>
<th>Alpha</th>
<th>Beta</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.22938</td>
<td>20</td>
<td>0.05000</td>
<td>0.00000</td>
<td>0.80000</td>
<td>0.80000</td>
<td>0.05000</td>
<td>0.05000</td>
<td>0.77062</td>
</tr>
<tr>
<td>0.13717</td>
<td>20</td>
<td>0.05000</td>
<td>0.00000</td>
<td>0.80000</td>
<td>0.80000</td>
<td>0.10000</td>
<td>0.05000</td>
<td>0.61280</td>
</tr>
<tr>
<td>0.43625</td>
<td>100</td>
<td>0.05000</td>
<td>0.00000</td>
<td>0.80000</td>
<td>0.80000</td>
<td>0.05000</td>
<td>0.05000</td>
<td>0.56375</td>
</tr>
<tr>
<td>0.28895</td>
<td>100</td>
<td>0.05000</td>
<td>0.00000</td>
<td>0.80000</td>
<td>0.80000</td>
<td>0.10000</td>
<td>0.05000</td>
<td>0.71105</td>
</tr>
<tr>
<td>0.67771</td>
<td>200</td>
<td>0.05000</td>
<td>0.00000</td>
<td>0.80000</td>
<td>0.80000</td>
<td>0.05000</td>
<td>0.05000</td>
<td>0.32229</td>
</tr>
<tr>
<td>0.46318</td>
<td>200</td>
<td>0.05000</td>
<td>0.00000</td>
<td>0.80000</td>
<td>0.80000</td>
<td>0.10000</td>
<td>0.05000</td>
<td>0.53682</td>
</tr>
<tr>
<td>0.83244</td>
<td>300</td>
<td>0.05000</td>
<td>0.00000</td>
<td>0.80000</td>
<td>0.80000</td>
<td>0.05000</td>
<td>0.05000</td>
<td>0.16756</td>
</tr>
<tr>
<td>0.60369</td>
<td>300</td>
<td>0.05000</td>
<td>0.00000</td>
<td>0.80000</td>
<td>0.80000</td>
<td>0.10000</td>
<td>0.05000</td>
<td>0.39631</td>
</tr>
<tr>
<td>0.94287</td>
<td>450</td>
<td>0.05000</td>
<td>0.00000</td>
<td>0.80000</td>
<td>0.80000</td>
<td>0.05000</td>
<td>0.05000</td>
<td>0.05713</td>
</tr>
<tr>
<td>0.75745</td>
<td>450</td>
<td>0.05000</td>
<td>0.00000</td>
<td>0.80000</td>
<td>0.80000</td>
<td>0.10000</td>
<td>0.05000</td>
<td>0.24255</td>
</tr>
<tr>
<td>0.98206</td>
<td>600</td>
<td>0.05000</td>
<td>0.00000</td>
<td>0.80000</td>
<td>0.80000</td>
<td>0.05000</td>
<td>0.05000</td>
<td>0.01794</td>
</tr>
<tr>
<td>0.85657</td>
<td>600</td>
<td>0.05000</td>
<td>0.00000</td>
<td>0.80000</td>
<td>0.80000</td>
<td>0.10000</td>
<td>0.05000</td>
<td>0.14343</td>
</tr>
<tr>
<td>0.99651</td>
<td>800</td>
<td>0.05000</td>
<td>0.00000</td>
<td>0.80000</td>
<td>0.80000</td>
<td>0.05000</td>
<td>0.05000</td>
<td>0.00349</td>
</tr>
<tr>
<td>0.93172</td>
<td>800</td>
<td>0.05000</td>
<td>0.00000</td>
<td>0.80000</td>
<td>0.80000</td>
<td>0.10000</td>
<td>0.05000</td>
<td>0.06828</td>
</tr>
<tr>
<td>0.99937</td>
<td>1000</td>
<td>0.05000</td>
<td>0.00000</td>
<td>0.80000</td>
<td>0.80000</td>
<td>0.05000</td>
<td>0.05000</td>
<td>0.00063</td>
</tr>
<tr>
<td>0.96070</td>
<td>1000</td>
<td>0.05000</td>
<td>0.00000</td>
<td>0.80000</td>
<td>0.80000</td>
<td>0.10000</td>
<td>0.05000</td>
<td>0.03130</td>
</tr>
</tbody>
</table>
Report Definitions
Power is the probability of rejecting a false null hypothesis.
N is the number of subjects, the sample size.
De is the maximum difference between the two proportions that is still called 'equivalent'.
Da is the actual difference between Pt and Ps. That is, Da = Pt - Ps.
Pt is the response proportion to the treatment (experimental or new) test.
Ps is the response proportion to the standard (reference or old) test.
The Nuisance Parameter is a value that is needed, but is not a direct part of the hypothesis.
Alpha is the probability of rejecting a true null hypothesis.
Beta is the probability of accepting a false null hypothesis.

Summary Statements
A sample size of 20 subjects achieves 23% power at a 5% significance level using a one-sided equivalence test of correlated proportions when the standard proportion is 0.80000, the maximum allowable difference between these proportions that still results in equivalence (the range of equivalence) is 0.05000, and the actual difference of the proportions is 0.00000.

This report shows the power for the indicated scenarios. All of the columns are defined in the ‘Report Definitions’ section.

Plots Section
These plots show the power versus the sample size for the two values of $P_01$. In this example, we see that the value of the nuisance parameter has a large effect on the calculated sample size.
Example 2 – Finding Sample Size

Continuing with Example 1, the analysts want to determine the exact sample size necessary to achieve 90% power for both values of the nuisance parameter.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Non-Inferiority Tests for Two Correlated Proportions using Differences procedure window by expanding Proportions, then Two Correlated Proportions, then clicking on Non-Inferiority, and then clicking on Non-Inferiority Tests for Two Correlated Proportions using Differences. You may then make the appropriate entries as listed below, or open Example 2 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Sample Size</td>
</tr>
<tr>
<td>Power</td>
<td>0.90</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>(</td>
<td>\text{De}) (Equivalence Difference))</td>
</tr>
<tr>
<td>(\text{Da}) (Actual Difference)</td>
<td>0.00</td>
</tr>
<tr>
<td>(\text{Ps}) (Standard Proportion)</td>
<td>0.80</td>
</tr>
<tr>
<td>Nuisance Parameter Type</td>
<td>(P01)</td>
</tr>
<tr>
<td>Nuisance Parameter Value</td>
<td>0.05 0.10</td>
</tr>
</tbody>
</table>

Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

| Numeric Results for a Non-Inferiority (One-Sided) Test of a Difference |
|--------------------|----------------|----------------|----------------|----------------|----------------|----------------|
| Power              | Sample Size (N) | Equiv. Difference (De) | Actual Difference (Da) | Treatment Proportion (Pt) | Standard Proportion (Ps) | Nuisance Parameter (P01) | Alpha | Beta |
| 0.90026            | 374            | 0.05000          | 0.00000         | 0.80000        | 0.80000        | 0.05000         | 0.05000 | 0.09974 |
| 0.90014            | 699            | 0.05000          | 0.00000         | 0.80000        | 0.80000        | 0.10000         | 0.05000 | 0.09986 |

This report shows that the sample size required nearly doubles when \(P01\) is changed from 0.05 to 0.10.
Example 3 – Validation using Liu

Liu et al. (2002) give an example in which P01 is 0.05, P10 is 0.05, Da is 0.00, De is 0.05, the significance level is 0.025, and the power is 80%. From their Table III, the sample size is 350.

In this example, the value of Ps is arbitrary. We set it at 0.50.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Non-Inferiority Tests for Two Correlated Proportions using Differences procedure window by expanding Proportions, then Two Correlated Proportions, then clicking on Non-Inferiority, and then clicking on Non-Inferiority Tests for Two Correlated Proportions using Differences. You may then make the appropriate entries as listed below, or open Example 3 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Sample Size</td>
</tr>
<tr>
<td>Power</td>
<td>0.80</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.025</td>
</tr>
<tr>
<td></td>
<td>De</td>
</tr>
<tr>
<td>Da (Actual Difference)</td>
<td>0.00</td>
</tr>
<tr>
<td>Ps (Standard Proportion)</td>
<td>0.50</td>
</tr>
<tr>
<td>Nuisance Parameter Type</td>
<td>P01</td>
</tr>
<tr>
<td>Nuisance Parameter Value</td>
<td>0.05</td>
</tr>
</tbody>
</table>

Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

<table>
<thead>
<tr>
<th>Numeric Results for a Non-Inferiority (One-Sided) Test of a Difference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power</td>
</tr>
<tr>
<td>-------</td>
</tr>
<tr>
<td>0.80046</td>
</tr>
</tbody>
</table>

The calculated sample size of 350 matches the results of Liu et al. (2002).
Example 4 – Validation using Nam and Blackwelder

Nam and Blackwelder (2002) give an example in which Ps is 0.80, P10 is 0.05, Ra is 1.00, Re is 0.80, the significance level is 0.05, and the power is 80%. From their Table III, the sample size is 34.

Note that their calculations use the approximate formula, so we will set the value of ‘Use Approximations if N is greater than’ to ‘1’ so that only the approximate formula is used.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Non-Inferiority Tests for Two Correlated Proportions using Ratios procedure window by expanding Proportions, then Two Correlated Proportions, then clicking on Non-Inferiority, and then clicking on Non-Inferiority Tests for Two Correlated Proportions using Ratios. You may then make the appropriate entries as listed below, or open Example 4 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Design Tab</strong></td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Sample Size</td>
</tr>
<tr>
<td>Power</td>
<td>0.80</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>Re (Equivalence Ratio)</td>
<td>0.80</td>
</tr>
<tr>
<td>Ra (Actual Ratio)</td>
<td>1.00</td>
</tr>
<tr>
<td>Ps (Standard Proportion)</td>
<td>0.80</td>
</tr>
<tr>
<td>Nuisance Parameter Type</td>
<td>P10</td>
</tr>
<tr>
<td>Nuisance Parameter Value</td>
<td>0.05</td>
</tr>
<tr>
<td><strong>Options Tab</strong></td>
<td></td>
</tr>
<tr>
<td>Use Approximations if N is greater than</td>
<td>1</td>
</tr>
</tbody>
</table>

Output

Click the Calculate button to perform the calculations and generate the following output.

**Numeric Results**

<table>
<thead>
<tr>
<th>Numeric Results for a Non-Inferiority (One-Sided) Test of a Ratio</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power</td>
</tr>
<tr>
<td>-------</td>
</tr>
<tr>
<td>0.80050</td>
</tr>
</tbody>
</table>

The calculated sample size of 34 matches the results of Nam and Blackwelder (2002).
Example 5 – Finding Sample Size for a Non-Inferiority Test

Researchers have developed a new treatment for migraine headaches which is less expensive than a current standard. The researchers need to show that the proportion of individuals who respond to the new treatment is not inferior to the standard treatment. They want to determine the minimum number of subjects required to achieve 90% power for the test of non-inferiority. The new treatment will be considered non-inferior if its success rate is no less than 90% of the success rate of the standard, which is about 0.65. The sample size required is evaluated for various values (0.3 to 0.9) of the nuisance parameter: $P_{11}/Ps = \text{sensitivity}$.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Non-Inferiority Tests for Two Correlated Proportions using Ratios procedure window by expanding Proportions, then Two Correlated Proportions, then clicking on Non-Inferiority, and then clicking on Non-Inferiority Tests for Two Correlated Proportions using Ratios. You may then make the appropriate entries as listed below, or open Example 5 by going to the File menu and choosing Open Example Template.

Option

Design Tab
Find .......................................................... Sample Size
Power ...................................................... 0.90
Alpha ....................................................... 0.05
Re (Equivalence Ratio)......................... 0.95
Ra (Actual Ratio) ................................. 1.0
Ps (Standard Proportion) ...................... 0.65
Nuisance Parameter Type ...................... $P_{11}/Ps (\text{Sensitivity})$
Nuisance Parameter Value .................... 0.3 to 0.9 by 0.1

Options Tab
Use Approximations if N is greater than: 1

Output

Click the Calculate button to perform the calculations and generate the following output.

<table>
<thead>
<tr>
<th>Power</th>
<th>Sample Size (N)</th>
<th>Equiv. Ratio (Re)</th>
<th>Actual Ratio (Ra)</th>
<th>Treatment Proportion (Pt)</th>
<th>Standard Proportion (Ps)</th>
<th>Nuisance Parameter Type (P11/Ps)</th>
<th>Alpha</th>
<th>Beta</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.90004</td>
<td>5013</td>
<td>0.95</td>
<td>1.00</td>
<td>0.65000</td>
<td>0.65000</td>
<td>0.30000</td>
<td>0.05000</td>
<td></td>
</tr>
<tr>
<td>0.90004</td>
<td>1020</td>
<td>0.95</td>
<td>1.00</td>
<td>0.65000</td>
<td>0.65000</td>
<td>0.40000</td>
<td>0.05000</td>
<td></td>
</tr>
<tr>
<td>0.9011</td>
<td>2020</td>
<td>0.95</td>
<td>1.00</td>
<td>0.65000</td>
<td>0.65000</td>
<td>0.50000</td>
<td>0.05000</td>
<td></td>
</tr>
<tr>
<td>0.9016</td>
<td>1035</td>
<td>0.95</td>
<td>1.00</td>
<td>0.65000</td>
<td>0.65000</td>
<td>0.60000</td>
<td>0.05000</td>
<td></td>
</tr>
</tbody>
</table>

These scenarios require a large sample size. In fact, the first two rows are blank because the sample size is so large it can’t be determined.